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Section 1 
Introduction  

�
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The On Demand Testing program uses software developed by the Victorian 
Curriculum and Assessment Authority (VCAA).  This software is referred to as 
VCAA Assessment Online. 

There are two components to the VCAA Assessment Online application – the 
Central Server and the School Server (see Figure 1.1). 

 

 

Figure 1.1 VCAA Assessment Online  

 

THE CENTRAL SERVER 

The Central Server is essentially a database that stores all public questions and 
tests the VCAA has created for the On Demand Testing program.  The Central 
Server is available via the internet and can be accessed from the following web 
address:  http://www.aimonline.vic.edu.au  

Each school is provided with a unique username and password for the Central 
Server site from where they can search, preview and download tests to their school.  
Contact the VCAA help desk (see page 3) if you do not have the appropriate login 
for this site. 

 

THE SCHOOL SERVER 

The School Server is the other component of VCAA Assessment Online.  The 
school is required to install software on a compatible server at the school.  This 
software is supplied free by the VCAA.  In government schools, this software is 
installed on the CASES21 server. Once this software has been installed and 
configured, schools can download tests from the Central Server.  The School 
Server must be set up in order to receive downloaded tests from the Central Server.   
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The School Server operates on the school’s local network and relies on the internet 
only for downloading tests from the Central Server.  Once the software is installed 
and configured, a dedicated website address is used to enable all users (Teachers 
and Students) to access the application within the school’s network via an Internet 
Explorer browser.  This is the School Server homepage.  The address for the 
School Server is unique in each school but will consist of four groups of digits, such 
as, http://123.45.67.89 (NB: this is just an example).  

Teacher and students access the School Server application and sit the tests within 
the school’s local area network (LAN) and do not rely on the internet during this time.  
In government schools, the School Server is accessible from the curriculum network 
even though the server resides on the CASES server on the administration network. 

Tests that are downloaded remain permanently on the School Server. You will need 
to import student details and create user accounts for other teachers at your school 
before you start testing online. This is covered in Section 3 - The School 
Administrator Role. 

Setting up test sessions, sitting tests and viewing reports is covered in Section 4 –
The Teacher Role.  All test results and student information is stored locally on the 
School Server. 

 

 

��
����
�

ONLINE HELP is available from both the Central Server and the School Server.  A 
Help link can be found on all pages in the top right hand corner of the screen (see 
Figure 1.2). 

 

Figure 1.2 Online Help 

The online help covers all functionality and includes some interactive videos.  It is 
the best place to go if you forget how to do a particular task or you want to 
investigate other features and functionality. 
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The VCAA ASSESSMENT ONLINE USER MANUAL FOR SCHOOLS is a 
comprehensive user manual that covers all aspects of the application and system, 
including function and features used internally by the VCAA.   

Schools should be aware that the User Manual was produced in 2004 and therefore 
includes references to CSF.  Whilst the main functions used by schools have not 
altered, addendums are available to cover new features, including new reports and 
the ‘Sync with CASES’ feature used by government schools.   

 

The HELP DESK - The Victorian Curriculum and Assessment Authority (VCAA) has 
established a help desk for schools that can be accessed using a freecall telephone 
service or by email. 

- The help desk operates from 8:30 am to 5:00 pm each business day. 

- The telephone number is 1800 623 681. 

- The email is aim.support@edumail.vic.gov.au 
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Section 2 
The Central Server  
� � �
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The VCAA Assessment Online Central Server is where School Administrators and 
Teachers can go to search, preview and download On Demand Tests.  The Central 
Server is accessed via the internet. Each school is supplied with a unique User ID 
and Password for the Central Server. 

1 Open Internet Explorer. 

2 Enter http://www.aimonline.vic.edu.au in the Address field and press the <Enter> 
key.  The VCAA Assessment Online Central Server homepage will appear (see 
Figure 2.1). 

 
Figure 2.1 VCAA Assessment Online homepage 

3 Left click on the On Demand Testing link on this page to get to the homepage for 
the On Demand program (see Figure 2.2). 

 

Figure 2.2 On Demand home page 
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4 Left click on the link for the On Demand Testing Login link under Teachers and 
Administrators and the Login window will appear (see Figure 2.3). 

 

Figure 2.3 Login window 

 

5 Enter the User ID and Password supplied by the VCAA and left click on the [Login] 
button. (Please Note: Passwords are case sensitive.) This will take you to the Home 
menu (see Figure 2.4). 

�

Figure 2.4 Central Server Home menu 

 


�
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6 From the Home menu, select Test Bank, then Download Test and then Public.  
The Download Test Search window will appear (see Figure 2.5). 
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Figure 2.5 Download Test Search window 

 

From the Download Test Search window you can narrow down your search by: 

� Selecting a Domain menu, and/or 

� Selecting or entering other criteria in the Search Criteria section, such as, 
Year Level or Test Flow (adaptive or linear).  

 

 

7 Select ‘Linear’ from the ‘Test Flow’ drop-down field in the Search Criteria and left 
click on the [Search] button.  A Search Result list will appear with a list of tests 
(see Figure 2.6). 

 

Figure 2.6 Test Search Results list 

 

Note: If no tests appear in the Search Result list, then there are no tests that match 
the criteria you have selected.  Left click on the [Reset] button to start a new search. 
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8 From the Search Result list, left click to highlight a linear test you wish to preview 
and then left click on the [View] button. The Linear Test View window will appear 
containing information about the tests you have selected (see Figure 2.7).   

  

 

Figure 2.7 Linear Test View window 

 
The Test View page contains information about the test you have selected.  
  

� The Linear Test View will list details of all the questions contained within 
the test such as the skill and Standard level of the question.  

 
 

9 Left click on the [Preview] button.  This enables you to preview the actual questions 
that will be presented to the students when they sit the linear test (see Figure 2.8).   

 
Figure 2.8 Preview of a linear test 
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It is possible to print the preview of linear tests to store a hard copy reference.  
(Please note that Adaptive Tests can only be administered online and therefore 
cannot be printed.) 

 
 

10 While in the preview mode, go to the File menu in the top left hand corner of your 
screen and select the Print option form the drop down menu (as shown in Figure 
2.8).   

 
11 This will open the Print dialogue box (see Figure 2.9). 
 

 
Figure 2.9 Print dialogue box 

 

12 Select your printing requirements and the appropriate printer, and then left click on 
the [Print] button. 

 
13 Scroll to the end of the Test Preview window and left click on the [OK] button at the 

bottom to close the window and be returned to the Linear Test View screen. 
 

� An [Answer Sheet] is also available from the Linear Test View window and 
can be printed in the same way (refer to Figure 2.7).  
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A PDF version of Linear tests can be generated via the [Preview As PDF] button.  
The PDF includes an answer sheet for teachers and a version of the test that can be 
administered in paper and pencil format.  Linear PDF tests can be saved to your 
computer or printed out. (Please note that Adaptive Tests can only be administered 
online and therefore no PDF version is available.) 
 

 
14 Left click on the [Preview As PDF] button to open a PDF version of the test.  The 

PDF version of the tests will open in a new window (see Figure 2.10).  
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Figure 2.10 Preview As PDF window 

 
15 If required, print the previewed test following steps 10 to 12 above.  Alternatively you 

can save a copy through the File menu and select the Save a Copy option.  
 
16 Close the PDF window and return to the Linear Test View screen.  
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17 To download the selected test, left click on the [Download] button from the Test 
View page.   

18 A message box will appear to advise that the download has been successfully 
queued (see Figure 2.11). Left click on the [OK] button to close the message box. 

 
� The request for the download will be placed in a queue and the test will be 

downloaded to your school.  This occurs in the background and you do not 
have to wait for the process to occur.  You can proceed to search, view and 
download other tests. 

 

 
Figure 2.11 Message Box 

 

19 From the Test View window (see Figure 2.12), left click on the [OK] button to return 
to the Search Criteria window and continue to search, view and download other 
tests. 
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Figure 2.12 Sample Test View window 
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20 From the Test Search window, search for an Adaptive test. 

21 Select an Adaptive test from the Search Result list and left click on the [View] 
button. The Adaptive Test View window will appear containing information about 
the test you have selected (see Figure 2.13).   

 

 
Figure 2.13 Adaptive Test View window 

� The Adaptive Test View does not show details of the test questions. There 
is no option to preview any of the questions, so there is no preview button 
for these tests. Answer Sheets are also not available for Adaptive tests. 

�
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Section 3 
The School Server (Part 1) 

�
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The School Administrator Role has additional functions to the Teacher Role on the 
School Server.  This includes importing and maintaining student details and managing 
users.  It is recommended that schools have more than one School Administrator as 
this role is also able to reset users if required. �
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 Instead of manually entering all student details individually, it is possible to import 
student details from other applications.  Student details can be imported by the VCAA 
Assessment Online School Administrator.   
 
For Government Schools, this can be done through the [Sync From CASES…] 
button.   
 
For Non-government Schools, this is possible through the [Import Students] button.  
A file of student details in the correct format is required.   
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 To synchronise student details from CASES: 
 
1. Open Internet Explorer and log into the School Server homepage via the 

Administration System (authorised users only) link (see Figure 3.1). 

For login instructions to the school sever, please refer to Section 4.1 of this guide. 

The School Server IP address can be placed as a favourite or a link on the school’s 
intranet for easy access by students and teachers. 

 

Figure 3.1 VCAA Assessment Online home page 
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2. From the Home menu, select Student Tracking and then School.  The School 

Search window will appear. 
 
3. Left click on the [Search] button to display the School Search Result list (see Figure 

3.2).   
 

  

Figure 3.2 School Search window, with school details 

 
4. Left click to highlight and select from the Search Result list, and then left click on 

[View] button.  The School View window will display data containing complete details 
for the selected school (see Figure 3.3).  Please contact the VCAA if these details are 
incorrect. 

 

  

Figure 3.3 Sample School View window 

 
5. Left click on the [Sync From CASES…] button.  The Sync From CASES window will 

appear (see Figure 3.4). 
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Figure 3.4 Sync From CASES window 

 
6. From the Year Level selection box, select a specific year level to synchronise OR 

leave this field blank to synchronise all year levels at your school. 
 
7. Left click on the [Synchronise] button.  If the synchronisation is successful, a 

message will appear (see Figure 3.5).   

  

Figure 3.5 Message that will appear if synchronisation is successful. 

 
8. Left click on [OK].  
 

Note: To confirm that student details have been correctly imported, return to the 
Student Tracking menu, select Student and then perform a search on the imported 
student data. (See the ‘Students’ folder in the online help files or the User Manual 
Section 4.2.) 
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Non-Government Schools will need to create a file containing student details as specified in 
the table on page 18.  This file may be created by extracting student data from the school’s 
administrative package. It is essential that the order and format of the data is correct.  The 
file must be saved in comma delimited (CSV) format.  A sample of a student import file is 
shown below in Figure 3.6.  
 
Once the file has been created and saved in CSV format, you are ready to import. 
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Figure 3.6 Sample Student Details Import file in the correct format 

 

To import student details from other applications: 
 
1 Open Internet Explorer and log into the School Server homepage via the 

Administration System (authorised users only) link (see Figure 3.7). 

The School Server IP address can be placed as a favourite or a link on the school’s 
intranet for easy access by students and teachers. 

 

Figure 3.7 VCAA Assessment Online home page 

 
2 From the Home menu, select Student Tracking and then School.  The School 

Search window will appear. 
 
3 Left click on the [Search] button to display the School Search Result list (see 

Figure 3.8).   
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Figure 3.8 School Search window, with school details 

 
4 Left click to highlight and select from the Search Result list, and then left click on 

[View] button.  The School View window will display data containing complete 
details for the selected school (see Figure 3.9).  Please contact the VCAA if these 
details are incorrect. 

   

Figure 3.9 Sample School View window 

 
5 Left click on the [Import Students] button.  The Import Students window will be 

displayed (see Figure 3.10). 
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Figure 3.10 Sample School View window 

 
6 Left click on the [Browse…] button.  The Choose File window will appear (see 

Figure 3.11). 

  

Figure 3.11 Choose file dialogue box 

 

7 Locate and select the Student Import file and left click to [Open]. 
 
8 Left click on the [Import] button.  If the import is successful, the School View 

window will appear and the process will be complete.  If the import is unsuccessful, 
the File Download dialogue box will appear (see Figure 3.12) and a log file will be 
produced describing the reason for the import failing. 

 

 
Figure 3.12 File Download dialogue box 
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9 Left click on the [Open] button. The log file will be opened.  Figure 3.13 shows a 

sample error log file. 

 
Figure 3.13 Sample error log file 

 

10 Rectify errors in the student import file. 

If Student Details Import fails, the file format may be wrong. Common reasons are:  

� the file is not saved in comma delimited (CSV) format 

� there are fields missing 

� there are fields in the wrong order 

� field lengths are wrong 

� data formats of fields are wrong. 

 
11 Re-try the Student Details Import process. 
 

Note: To confirm that student details have been correctly imported, return to the 
Student Tracking menu, select Student and then perform a search on the imported 
student data. (See the ‘Students’ folder in the online help files or the User Manual 
Section 4.2.) 
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Field In the field…  Enter this information… Mandatory? 

1 Student Code This is the unique student identifier  Yes 

2 First Name Student’s first name Yes 

4 Middle Name  Student’s middle name. If empty then you must still 
include the comma, e.g. John Anderson would 
be ,John,,Anderson, 

No 

3 Surname Student’s surname Yes 

4 Gender MALE for male and FEMAL for females 
Will also accept M, MALE, F , FEMALE values 

Yes 

6 Date of Birth Student’s birth date in: 
MMM dd yyyy format, e.g. Apr 3 1994 Or 
dd/mm/yyyy format, e.g. 24/03/1994 
(Ensure PC is in Australian or United Kingdom 
date setting to ensure date and month are not 
switched around inadvertently) 

Yes 

7 LBOTE 
Language 
Background 
Other Than 
English 

1 if the student has a language background other than 
English, 0 if not  
Will also accept Y, Yes, T, True for 1  
Will also accept N, No, F, False for 0 

Yes 

8 ATSI 
Aboriginal or 
Torres Strait 
Islander 

1 if the student is an Aboriginal or  
Torres Strait Islander, 0 if not 
Will also accept Y, Yes, T, True for 1 
Will also accept N, No, F, False for 0 

Yes 

9 Disability 1 if the student has a disability, 0 if not 
Will also accept Y, Yes, T, True for 1 
Will also accept N, No, F, False for 0 

Yes 

10 EMA 
Education 
Maintenance 
Allowance 

1 if the student is receiving the Education  
Maintenance Allowance, 0 if not   
Will also accept Y, Yes, T, True for 1 
Will also accept N, No, F, False for 0 

Yes 

11 ESL 
English as a 
Second 
Language 

1 if English is the student’s second language, 0 if not 
Will also accept Y, Yes, T, True for 1 
Will also accept N, No, F, False for 0 

Yes 

12 Home Group Student’s home group. If empty then you must still 
include the comma 

No 

14 Year Level Can be as 7, 8, 9 etc or with leading zeros,  
i.e. 07, 08, 09 etc 

Yes 
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When creating user accounts for teachers on the School Server, the Login ID must 
be unique. One suggestion is to use employee codes as this is something that 
teachers will easily remember.  The password may be set as ‘password’ in the first 
instance and then teachers should be advised to change their password when they 
first log in. 

Users can be assigned either a ‘Teacher’ role or a ‘School Administrator’ role or 
both as required.  The School Administrator has additional administrative functions 
such as setting up and maintaining student details and other user accounts.  It is 
advised that there are at least two School Administrators at a school. 

For steps on Editing, Disabling or Deleting Users please refer to the relevant 
sections within the ‘Online Help’ located in the ‘Users’ folder or ‘Chapter 4 of the 
VCAA Assessment Online User Manual ‘. 

 

1 Open Internet Explorer and log into the School Server homepage via the 
Administration System (authorised users only) link (see Figure 3.14). 

 

Figure 3.14 VCAA Assessment Online home page 

 

2 From the Home menu, select Security, then select Users.  A Search window will 
appear with a [New] button (see Figure 3.15). 
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Figure 3.15 Users Search window 

3 Left click on the [New] button.  This will open the User Edit window (see Figure 
3.16). 

 

Figure 3.16 User Edit window 

 

4 Enter the following information to create a new user. 

Field… Information… 

Logon Id User ID 

First Name User’s first name 

Middle Name User’s middle name (optional) 

Surname User’s family name 

Source Always select ‘School’ from dropdown list  
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Password User’s password (mandatory when creating a user) 

Confirm Password User’s password  (mandatory when creating a user) 

School 
Click on the   button to open the School Search 
window. Click on the [Search] button to display and 
select your school. 

Role  
Click the Roles tab, then [Add] to enter roles. Multiple 
roles can be selected by clicking on the [Add] button 
again. 

 

5 Left click on the [OK] button to return to the Users Search and Results window.  

6 Preform a search from the User Search window to confirm that the user has been 
successfully created. 

7 Notify the user of their account details and advise them to change their password 
when they log in. 
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Reactivating a user allows the user to access the VCAA Assessment Online system 
after a period of not being authorised to, or if the user is locked out after exceeding 
the maximum number of login attempts.  Note: As a security measure, the system 
allows three attempts at logging in before a user is deactivated. 

 

1 Open Internet Explorer and log into the School Server homepage via the 
Administration System (authorised users only) link (see Figure 3.17). 

 

Figure 3.17 VCAA Assessment Online home page 

2 From the Home menu, select Security, then select Users.  A Search window will 
appear (see Figure 3.18). 
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Figure 3.18 Users Search window 

3 Enter details in the Search Criteria window and then left click on the [Search] button.  
This should display a result list of matches to your search criteria (see Figure 3.19).  
If the result list does not list the user you are searching for, left click on the [Reset] 
button and try the search again. 

 
Figure 3.19 Users Search Result list 

 

4 When you have located the user, select by clicking onto the row to highlight that 
user and left click on the [View] button (see Figure 3.19).  This will display the User 
View window (see Figure 3.20). 
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Figure 3.20 User View window. 

5 You will note the number of Logon Attempts will be a number greater than 3.  Left 
click on the [Make Active] button to reset the user (see Figure 3.20).  The Logon 
Attempts will update to 0 and the user has been re-activated. 
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Section 4 
The School Server (Part 2) 
 
� ������������'����

There are two main roles used by the On Demand Testing program.  They are the 
Teacher role and the School Administrator role.  The basic difference between the 
two is that the School Administrator has added functions, such as maintaining 
student data and users of the system.  Both roles can set up test sessions and view 
reports on student test results.  You may wish to allocate one or two users at the 
school with the School Administrator role and have all other users with the Teacher 
role.  � �

�
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1 Open Internet Explorer. 

2 Enter the School Server IP address in the Address field and press the <Enter>.  The 
School Server home page will appear (see Figure 4.1). 

The School Server IP address can be placed as a favourite or a link on the school’s 
intranet for easy access by students and teachers. 

 

Figure 4.1 School Server homepage 

 

3 Left click on the link for the Administration System (authorised users only) and 
the Login window will appear (see Figure 4.2). 
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Figure 4.2 Login window 

4 Enter the User ID and Password supplied, for accessing the Administration System, 
and left click on the [Login] button to display the Home menu (see Figure 4.3). 

  

Figure 4.3 Home menu for the Teacher Role 
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1 Open Internet Explorer and log into the School Server homepage via the 
Administration System (authorised users only) link.  

2 From the Home menu, select Test Delivery, then select Public.  The Test Search 
window will appear (see Figure 4.4). 
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Figure 4.4 Test Search window 

 

3 From the Test Search window you can narrow down your search by: 

a. Selecting a Domain menu, and/or 

b. Selecting or entering other criteria in the Selection Criteria section, such 
as, Year Level or Test Flow.  

4 When you have made a selection, left click on the [Search] button.  A Search 
Result list will appear with a list of tests (see Figure 4.5). 

 

Figure 4.5 Test Search Results list 

Note: If no tests appear in the Search Result list, then there are no tests that match 
the criteria you have selected.  Left click on the [Reset] button to start a new search. 

If you do not select a domain or make a selection from the Selection Criteria section, 
then the Search Result list will display all tests that have been downloaded to the 
school server at your school. 

 

5 From the Result List, left click to highlight the test you require and then left click on 
the [Sessions] button, as shown in Figure 4.5. A Test Sessions Search window 
will appear (see Figure 4.6).   
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Figure 4.6 Test Sessions Search window 

 
6 Left click on the [New] button as shown in Figure 4.6.  The Test Session Edit 

window will appear (see Figure 4.7). 

The Activation Date* and Activation Time* displayed in the Test Session Edit 
window will default to the current date and time.  Edit this if desired, then enter the 
Key Life (hrs)* and click on the [Apply] button. 

For Linear tests only, Test Session Length (mins) should be entered to control 
how long the students will have for their test. 

 

 

 

Figure 4.7 Test Session Edit window 

 

7 Note down the session key displayed in the message box (see Figure 4.8) and left 
click on the [OK] button to close the message box.  This session key is to be given 
to the students for logging into the test. 
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Figure 4.8 Message box 

8 Left click on the [Cancel] button in the Test Session Edit window (see Figure 4.7) to 
return to the previous screen.  You will be presented with a list of all Session Keys 
for this test including the one you have just created (see Figure 4.9). 

 

Figure 4.9 Session Key list 

 

NOTE: Session Keys that have expired can be reactivated by editing the key life, 
date or time. This will replace the expired Session Key with a new one. (See the 
‘Editing test sessions’ folder in the online help files or the User Manual Section 8.1.3) 
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1 Students should be advised to open an Internet Explorer window and go to the 
School Server homepage (see Figure 4.10).  

For quick access it is a good idea to have the School Server homepage saved as a 
favourite or a shortcut on the desk top of each work station. 
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Figure 4.10 School Server home page 

 

2 Students should left click on the Start Test link. 

3 You will need to provide the students with the Session Key that you have created 
for the test you wish to administer - from the section on ‘Creating a Test Session’. 

Other information that students will need in order to log in and complete the test is 
their Student Code and their Day and Month of Birth (see Figure 4.11). For 
Government schools, the Student Code is the student’s CASES ID. 

 

Figure 4.11 Student login screen 

 

4 Once they have entered the required details, the student should left click on the 
[Login] button.  The student’s details will be displayed and the student will need to 
confirm that this is correct before proceeding with the test (see Figure 4.12). 

 

Figure 4.12 Student confirmation screen 
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Problems starting the test? 

� Check pop-up blockers are disabled. 

� Check that ActiveX controls are enabled. 

� If using Windows XP with Service Pack 2, check that additional set up has been 
completed. Refer to the helpdesk for advise on this. 
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 Things to know about Linear Tests: 

� A linear test is a test which has a set number of questions.  Each student sees 
the same set of questions and they are presented to every student in the same 
order. 

� When students sit a linear test, they will have a [Next Question], [Previous 
Question], and a [Summary List] button from which they can navigate their 
way through the test (see Figure 4.13). 

� A score can be displayed to the student at the end of the test if this option has 
been selected when the Session Key was created (see the User Manual or the 
Online help pages for further details). 

 

Figure 4.13 Linear Test view 
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 Things to know about Adaptive Tests: 

� An adaptive test is a test of a student’s ability.  Each student is presented with a 
set of questions and depending on how they answer the questions, the next set 
of questions they are presented with will be of either a higher or a lower level of 
difficulty. As the student progresses through the test they will be presented with 
a unique variety of questions to suit their ability. 

� Due to the nature of adaptive tests, it is NOT possible to go back to previous 
questions to change or review responses.  Students can only move forward to 
the next question (see Figure 4.14). 
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� Each question is timed.  A warning is presented on the screen 10 seconds 
before the time expires (see Figure 4.14).  

� If a student skips a question or the question times out before they have given a 
response, then that question will be marked as incorrect. 

  

Figure 4.14 Adaptive test view 
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Tests can be temporarily or permanently stopped by teachers if required.  To do this: 

1 On the student’s workstation as they are sitting the test, press the <Ctrl> and <K> 
keys on the key board at the same time. 

2 An administration login window will appear (see Figure 4.15).  Enter your own 
username and password in the fields and left click on the [Login] button. 

 

Figure 4.15 Administration Login page for interrupting tests 

 

3 The Student Test Administration window will appear (see Figure 4.16) where you 
can make one of the following selections: 
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� [Pause] – will temporarily pause the test and any associated timers.  The 
student can click on the [Continue] button on the screen when they return, to 
resume from the last question they were at. 

� [End Test] – will end the session and save all responses that the student has 
competed up to this point.  

 Note: It is recommended that the END TEST feature is NOT used for 
Adaptive tests.  Students need to complete all questions of an Adaptive test in 
order to generate a valid score. 

� [Cancel Session] – will end the session but will NOT save any of the 
responses that the student has completed. 

        

Figure 4.16 Student Test Administration window 
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It is possible to generate reports immediately after students have completed tests. 

1 Open Internet Explorer and log into the School Server homepage via the 
Administration System (authorised users only) link (see Figure 4.17). 

 

Figure 4.17 VCAA Assessment Online home page 
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2 From the Home menu, left click on the Reports menu.  This will open a Reports 
Parameter screen in a new window (see Figure 4.18). You can choose to maximise 
this window if required. 

 

Figure 4.18 Report Parameters window 

3 Select the Report Type depending on the type of test you wish to view results for - 
Linear or Adaptive (see Figure 4.19). 

 

Figure 4.19 Maximized Report Parameters window  

4 Select a Report Name from the list (see Figure 4.19). This will display a Selection 
Criteria window (see Figure 4.20). 

 

Figure 4.20 Selection Criteria window 

5 Enter the Test Number then either press the [Enter] key on your keyboard or left 
mouse click to enable the other options for selection (see Figure 4.20). 



 

34    | SECTION 4 – THE SCHOOL SERVER    

6 Make further selections from the Selection Criteria options to narrow down to the 
data and result you wish to view.  For instance, you may want to run the report for a 
particular Home Group or Year Level (see Figure 4.21). 

 

Figure 4.21 Selection Criteria window with parameters selected 

7 Left click on the [Preview Report] button. The Report page will open in a new 
window (see Figure 4.22). 

 

Figure 4.22 Preview Report window 

8 To print reports, left click on the Print link to open a Print Dialogue box.  You may 
need to change the print orientation to Landscape.  The Print link can be found in 
the top right corner of the Preview Report window (see Figure 4.22). 

9 Reports can also be exported into a Word document.  Left click on the Export link. 
The Export link can be found in the top right corner of the Preview Report window 
(see Figure 4.22). 

10 When you have finished, left click on the Close link to close the report page before 
you select another report to preview. The Close link can be found in the top right 
corner of the Preview Report window (see Figure 4.22). 
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Problems generating reports? 

If you cannot display the Report Parameters window or the Preview Report window, you 
may need to check that pop-up blockers have been disabled for this site.  Refer to the 
helpdesk if you require assistance with this. 

 


